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ВВЕДЕНИЕ 

Полиграфия — обобщенное понятие, как для различных направлений 

отрасли печатной промышленности, так и огромного многообразия полиграфи-

ческой продукции, ежедневно применяемой нами в самых разных целях. С по-

лиграфией мы сталкиваемся ежедневно: и дома, и на улице, и в офисе. Ассор-

тимент продукции полиграфии, выпускаемой современными типографиями, 

невероятно широк: это листовки и буклеты, книги, журналы и газеты, плакаты 

и постеры, брошюры и каталоги, открытки и приглашения, упаковка, этикетки, 

наклейки, стикеры и даже бюллетени для выборов в государственные органы 

власти. Без полиграфии и полиграфической продукции в наше время невоз-

можно существование бизнеса, к какой бы сфере он ни принадлежал. 

Согласно определению, полиграфия — это процесс многократного полу-

чения изображения (его тиражирования) на запечатываемом материале пу-

тем переноса краски с какого-либо носителя. И занимаются этим процессом 

тиражирования печатных изделий (иначе говоря, печатью или печатанием) 

полиграфические предприятия — типографии. 
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1. ЦВЕТ В ПОЛИГРАФИИ 

1.1. Полиграфическая цветовая модель CMYK 

 

Рис. 1. Графическая модель CMYK 

Система CMYK создана и используется для типографической печати. 

Аббревиатура CMYK означает названия основных красок, использующихся для 

четырехцветной печати: голубой (Сyan), пурпурный (Мagenta) и желтый 

(Yellow). Буквой К обозначают черную краску (BlacK), позволяющую добиться 

насыщенного черного цвета при печати. Используется последняя, а не первая 

буква слова, чтобы не путать Black и Blue. 

1.2. Как формируется цвет CMYK? 

Каждое из чисел, определяющее цвет в CMYK, представляет собой про-

цент краски данного цвета, составляющей цветовую комбинацию. Например, 

для получения тёмно-оранжевого цвета следует смешать 30 % голубой краски, 

45 % пурпурной краски, 80 % жёлтой краски и 5 % чёрной. Это можно обозна-

чить следующим образом: (30/45/80/5). 

1.3. Где используются изображения в режиме CMYK? 

Область применения цветовой модели CMYK – полноцветная печать. 

Именно с этой моделью работает большинство устройств печати. Из-за несоот-

ветствия цветовых моделей часто возникает ситуация, когда цвет, который 

нужно напечатать, не может быть воспроизведен с помощью модели CMYK 

(например, золотой или серебряный). В этом случае применяются краски 
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Pantone (готовые смешанные краски множества цветов и оттенков), их также 

называют плашечными (поскольку эти краски не смешиваются при печати, а 

являются кроющими). 

2. ГРАФИЧЕСКИЕ РЕДАКТОРЫ 

Макет в полиграфии – предварительный образец книги, журнала, ли-

стовки, брошюры или другого издания, изготовляемый в одном из графических 

редакторов. 

Графический редактор — программа (или пакет программ), позволяю-

щая создавать, просматривать, обрабатывать и редактировать цифровые изоб-

ражения (рисунки, картинки, фотографии) на компьютере. 

Типы графических редакторов: 

 Растровые графические редакторы.  

Наиболее популярные профессиональные растровые графические редак-

торы: платный Adobe Photoshop (для операционных систем Windows и Windows 

Phone, Mac OS X и iOS, Android) и его бесплатный аналог GIMP и Krita (для 

операционных систем Linux и Windows, Free BCD и Solaris), распространяемый 

под лицензией GNU GPL, а также менее известные графические редакторы для 

начинающих: любительский Photofiltre и учебный Paint.NET. 

 Векторные графические редакторы. Наиболее популярные про-

фессиональные векторные графические редакторы: платный Adobe Illustrator, 

Adobe InDesign и платный Corel Draw (для операционных систем Microsoft 

Windows и Mac OS X), а также свободно распространяемый и бесплатный гра-

фический редактор Inkscape — для всех ОС. 

 Гибридные графические редакторы. Наиболее популярны: 

RasterDesk для AutoCAD, Spotlight для операционных систем Microsoft 

Windows. Редакторы растровой графики Adobe Photoshop также поддерживают 

некоторые функции для работы с векторной графикой. Adobe Illustrator и 

Corel Draw также поддерживают некоторые функции для работы с растровой 

графикой. 

https://ru.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BC%D0%BF%D1%8C%D1%8E%D1%82%D0%B5%D1%80%D0%BD%D0%B0%D1%8F_%D0%BF%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D0%BC%D0%B0
https://ru.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BC%D0%BF%D1%8C%D1%8E%D1%82%D0%B5%D1%80
https://ru.wikipedia.org/wiki/%D0%A0%D0%B0%D1%81%D1%82%D1%80%D0%BE%D0%B2%D1%8B%D0%B9_%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%87%D0%B5%D1%81%D0%BA%D0%B8%D0%B9_%D1%80%D0%B5%D0%B4%D0%B0%D0%BA%D1%82%D0%BE%D1%80
https://ru.wikipedia.org/wiki/Adobe_Photoshop
https://ru.wikipedia.org/wiki/%D0%9E%D0%BF%D0%B5%D1%80%D0%B0%D1%86%D0%B8%D0%BE%D0%BD%D0%BD%D0%B0%D1%8F_%D1%81%D0%B8%D1%81%D1%82%D0%B5%D0%BC%D0%B0
https://ru.wikipedia.org/wiki/Microsoft_Windows
https://ru.wikipedia.org/wiki/Windows_Phone
https://ru.wikipedia.org/wiki/Windows_Phone
https://ru.wikipedia.org/wiki/Mac_OS_X
https://ru.wikipedia.org/wiki/IOS
https://ru.wikipedia.org/wiki/Android
https://ru.wikipedia.org/wiki/GIMP
https://ru.wikipedia.org/wiki/Krita
https://ru.wikipedia.org/wiki/GNU/Linux
https://ru.wikipedia.org/wiki/Windows
https://ru.wikipedia.org/wiki/FreeBSD
https://ru.wikipedia.org/wiki/Solaris
https://ru.wikipedia.org/wiki/GNU_General_Public_License
https://ru.wikipedia.org/wiki/PhotoFiltre
https://ru.wikipedia.org/wiki/Paint.NET
https://ru.wikipedia.org/wiki/%D0%92%D0%B5%D0%BA%D1%82%D0%BE%D1%80%D0%BD%D1%8B%D0%B9_%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%87%D0%B5%D1%81%D0%BA%D0%B8%D0%B9_%D1%80%D0%B5%D0%B4%D0%B0%D0%BA%D1%82%D0%BE%D1%80
https://ru.wikipedia.org/wiki/Adobe_Illustrator
https://ru.wikipedia.org/wiki/Adobe_Illustrator
https://ru.wikipedia.org/wiki/Corel_Draw
https://ru.wikipedia.org/wiki/%D0%9E%D0%BF%D0%B5%D1%80%D0%B0%D1%86%D0%B8%D0%BE%D0%BD%D0%BD%D0%B0%D1%8F_%D1%81%D0%B8%D1%81%D1%82%D0%B5%D0%BC%D0%B0
https://ru.wikipedia.org/wiki/Microsoft_Windows
https://ru.wikipedia.org/wiki/Microsoft_Windows
https://ru.wikipedia.org/wiki/Mac_OS_X
https://ru.wikipedia.org/wiki/Inkscape
https://ru.wikipedia.org/wiki/%D0%9E%D0%BF%D0%B5%D1%80%D0%B0%D1%86%D0%B8%D0%BE%D0%BD%D0%BD%D0%B0%D1%8F_%D1%81%D0%B8%D1%81%D1%82%D0%B5%D0%BC%D0%B0
https://ru.wikipedia.org/w/index.php?title=%D0%93%D0%B8%D0%B1%D1%80%D0%B8%D0%B4%D0%BD%D1%8B%D0%B9_%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%87%D0%B5%D1%81%D0%BA%D0%B8%D0%B9_%D1%80%D0%B5%D0%B4%D0%B0%D0%BA%D1%82%D0%BE%D1%80&action=edit&redlink=1
https://ru.wikipedia.org/wiki/RasterDesk
https://ru.wikipedia.org/wiki/AutoCAD
https://ru.wikipedia.org/wiki/Spotlight_%28%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%87%D0%B5%D1%81%D0%BA%D0%B8%D0%B9_%D1%80%D0%B5%D0%B4%D0%B0%D0%BA%D1%82%D0%BE%D1%80%29
https://ru.wikipedia.org/wiki/%D0%9E%D0%BF%D0%B5%D1%80%D0%B0%D1%86%D0%B8%D0%BE%D0%BD%D0%BD%D0%B0%D1%8F_%D1%81%D0%B8%D1%81%D1%82%D0%B5%D0%BC%D0%B0
https://ru.wikipedia.org/wiki/Microsoft_Windows
https://ru.wikipedia.org/wiki/Microsoft_Windows
https://ru.wikipedia.org/wiki/Adobe_Photoshop
https://ru.wikipedia.org/wiki/Adobe_Illustrator
https://ru.wikipedia.org/wiki/Corel_Draw
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Основные графические редакторы, используемые для создания макетов: 

Corel Draw, Adobe Photoshop, Adobe Illustrator, Adobe InDesign. 

3. ПРОИЗВОДСТВО ПОЛИГРАФИЧЕСКОЙ ПРОДУКЦИИ 

Непосредственно сам цикл производства печатной продукции (печати) 

происходит в три этапа. 

 Подготовка готового макета к печати 

 Печать 

 Послепечатная обработка 

3.1. Подготовка готового макета к печати 

Первый этап – это подготовка макета к печати: проверка готового маке-

та, приведение макета к требованиям по изготовлению того или иного вида пе-

чатной продукции, сборка спусковых полос (распределение особым образом 

полос макета для последующей послепечатной обработки) и т.д.  

Процесс приведения макета к требованиям печати более подробно рас-

сматривается в разделе «Подготовка макета к печати». 

Второй этап – собственно сам процесс печати. Как ни странно, но в 

большинстве случаев этот этап занимает меньше всего времени во всем цикле 

производства и обуславливается в основном техническими характеристиками и 

состоянием печатной машины.  

Ну и последний, третий, этап производства печатной продукции – по-

слепечатная обработка. Сюда входит множество разновидностей процессов для 

придания нужного внешнего вида печатной продукции.  

Любой вид печатной продукции нуждается в послепечатной обработке, 

как минимум в резке. В некоторых случаях время, необходимое на послепечат-

ную обработку при изготовлении данного изделия, может в несколько раз пре-

вышать время, затраченное на печать и даже на разработку и подготовку маке-

та. 
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3.1.1. Форматы бумаги и ее размеры 

Формат бумаги — стандартизованный размер бумажного листа. В раз-

ных странах в разное время были приняты в качестве стандартных различные 

форматы.  

В настоящее время доминируют две системы: международный стандарт 

(A4 и сопутствующие) и североамериканская. Международный стандарт на бу-

мажные форматы, ISO 216, основан на формате бумажного листа, имеющего 

площадь в 1 м². Стандарт был принят всеми странами, за исключением Соеди-

нённых Штатов и Канады. В Мексике и на Филиппинах, несмотря на принятие 

международного стандарта, американский формат «Letter» по прежнему широ-

ко используется. 

Все форматы бумаги ISO имеют одно и то же отношение сторон, равное 

квадратному корню из двух, это отношение примерно равно 1:1,41.  

Наиболее широко известный формат стандарта ISO — формат A4. Так-

же этот стандарт полагает три серии форматов  — A, B и C 

 

Серия A Размер Серия B Размер Серия C Размер 

A0 1189x841 мм B0  1000x1414 мм C0 1297x917 мм 

A1 841x594 мм B1 707x1000 мм C1 917x648 мм 

A2 594x420 мм B2 500x707 мм C2 648x458 мм 

A3 420x297 мм B3 353x500 мм C3 458x324 мм 

A4 297x210 мм B4 250x353 мм C4 324x229 мм 

A5 210x148 мм B5 176x250 мм C5 229x162 мм 

A6 148x105 мм B6 125x176 мм C6 162x114 мм 

A7 105x74 мм B7 88x125 мм C7 114x81 мм 

A8 74x52 мм B8  88x62 мм C8 81x57 мм 
 

     

      

      

Серия A 



9 

 

Наибольший стандартный размер, чаще всего используемый для печати 

различной полиграфической продукции.  

Серия B 

Серия B почти не используется в офисе, но имеет ряд специальных при-

менений, например, в этих форматах выходят многие постеры, B5 часто ис-

пользуется для книг, также эти форматы применяются для конвертов и паспор-

тов.  

Серия C 

Серия C используется только для конвертов и определяется в ISO 269.  

3.1.2. Виды полиграфической продукции 

Выпускаемая в настоящее время печатная продукция очень разно-

образна по своему виду, конкретному назначению, срокам издания, техниче-

скому исполнению. Ниже перечислены наиболее востребованные на данный 

момент виды печатной продукции.  

 Бланк 

 Листовка 

 Буклет 

 Брошюра 

 Календарь 

 Визитная карточка 

 Папка 

 Блокнот 

 Конверт 

 Кубарик 

 Этикетка 

 Ярлык 

Бланк. Бумажный лист, как правило формата А4 и менее, содержащий 

элементы фирменного стиля или информацию постоянного, предназначен для 

последующего заполнения.  
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Листовка. Бумажный лист, как правило формата А4, запечатанный с 

одной или обеих сторон, в одну или несколько красок, рекламного или инфор-

мационного содержания. Предполагает несколько более высокое качество по-

лиграфического исполнения, чем у бланка. 

Буклет. Непериодическое листовое издание в виде одного листа печат-

ного материала, сфальцованного (сложенного) в 2 и более сгибов. 

Брошюра. Непериодическое текстовое книжное издание объемом свыше 

4 страниц, соединенных между собой при помощи клея, пружины, шитья 

скрепкой или ниткой.  

Календарь.Печатное издание, обязательно имеющее в своем составе ка-

лендарную сетку. Календари бывают: карманные, квартальные, перекидные ка-

лендари на ригеле, календари «домик» и «домик перекидной».  

Визитная карточка. Листок плотной бумаги или картона, обычно фор-

мата 50х90 мм (иногда других форматов), содержащий сведения о человеке или 

фирме. 

Папка. Изделие из плотной бумаги, картона или полимера, предназна-

ченное для хранения небольшого числа листов бумаги. В основном использует-

ся как элемент фирменного стиля. Различают несколько видов: цельнокройные 

(изготавливаются из целого листа материала), с приклеенными карманами 

(карман-клапан изготавливается из отдельного листа материала и затем при-

клеивается к «корочкам»), с замковым скреплением (папку можно разложить в 

плоскость, а затем собрать вновь, не разрывая ее), с клеевым скреплением. 

Блокнот. Сшитая или склеенная с торца стопка бумаги, чистой или с 

нанесенными элементами фирменного стиля, с обложкой. 

Конверт. Один из видов носителя фирменного стиля. Существует боль-

шое разнообразие видов конвертов. 

Кубарик. Стопка бумаги небольшого формата, проклеенная с одной сто-

роны для лёгкости отрыва. Используется для оперативных записей. Как прави-

ло, несет элементы фирменного стиля. 
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Этикетка. Листок специальной (этикеточной) бумаги небольшого фор-

мата, содержащий сведения о товаре или продукции. Предполагает клеевой 

способ крепления. 

Ярлык. Листок картона небольшого формата, содержащий сведения о 

товаре или продукции и сопровождающий её, предполагающий навесной спо-

соб крепления. 

3.2. Различные способы печати 

Офсетная печать (в полиграфии, от англ. off-set — без контакта с пе-

чатной формой) — технология печати, предусматривающая перенос краски с 

печатной формы на запечатываемый материал не напрямую, а через промежу-

точный офсетный цилиндр. Соответственно, в отличие от прочих методов печа-

ти, изображение на печатной форме делается не зеркальным, а прямым. Офсет 

применяется главным образом в плоской печати 

Принцип действия. В традиционной офсетной печати краска попадает на 

бумагу, проходя как минимум два вала — один из них называется валом с фор-

мой, а другой — офсетным валом.  

Затем на форму наносится изображение. После экспонирования и прояв-

ки засвеченные части формы начинают притягивать воду и отталкивать любую 

маслянистую субстанцию, в частности, краску.  

Оставшиеся части форм начинают, наоборот, отталкивать воду и притя-

гивать краску. Таким образом, краска переносится исключительно на гидро-

фобные части формы, формируя буквы и изображения. При каждом повороте с 

помощью системы увлажняющих валиков вал с печатной формой омывается 

водой, затем через систему красочных валиков на его гидрофобные части нано-

сится краска. Изображение переносится с вала с печатной формой на офсетный 

вал, а оттуда — на бумагу. Офсетный вал способствует меньшему износу форм 

и большей ровности краски. 

Печать цветных изображений. С помощью описанной выше техноло-

гии можно получить изображение только одного цвета — цвета краски, исполь-

зуемой в красочных валиках. Есть несколько способов напечатать цветное 

https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%8F
https://ru.wikipedia.org/wiki/%D0%90%D0%BD%D0%B3%D0%BB%D0%B8%D0%B9%D1%81%D0%BA%D0%B8%D0%B9_%D1%8F%D0%B7%D1%8B%D0%BA
https://ru.wikipedia.org/wiki/%D0%A2%D0%B5%D1%85%D0%BD%D0%BE%D0%BB%D0%BE%D0%B3%D0%B8%D1%8F
https://ru.wikipedia.org/wiki/%D0%9F%D0%B5%D1%87%D0%B0%D1%82%D0%BD%D0%B0%D1%8F_%D1%84%D0%BE%D1%80%D0%BC%D0%B0
https://ru.wikipedia.org/wiki/%D0%9F%D0%BB%D0%BE%D1%81%D0%BA%D0%B0%D1%8F_%D0%BF%D0%B5%D1%87%D0%B0%D1%82%D1%8C
https://ru.wikipedia.org/wiki/%D0%9E%D1%84%D1%81%D0%B5%D1%82%D0%BD%D0%B0%D1%8F_%D0%B1%D1%83%D0%BC%D0%B0%D0%B3%D0%B0
https://ru.wikipedia.org/w/index.php?title=%D0%9E%D1%84%D1%81%D0%B5%D1%82%D0%BD%D1%8B%D0%B9_%D0%B2%D0%B0%D0%BB&action=edit&redlink=1
https://ru.wikipedia.org/wiki/%D0%9F%D0%B5%D1%87%D0%B0%D1%82%D0%BD%D0%B0%D1%8F_%D1%84%D0%BE%D1%80%D0%BC%D0%B0
https://ru.wikipedia.org/wiki/%D0%9F%D0%B5%D1%87%D0%B0%D1%82%D0%BD%D0%B0%D1%8F_%D1%84%D0%BE%D1%80%D0%BC%D0%B0
https://ru.wikipedia.org/wiki/%D0%AD%D0%BA%D1%81%D0%BF%D0%BE%D0%BD%D0%B8%D1%80%D0%BE%D0%B2%D0%B0%D0%BD%D0%B8%D0%B5
https://ru.wikipedia.org/wiki/%D0%9F%D1%80%D0%BE%D1%8F%D0%B2%D0%BA%D0%B0
https://ru.wikipedia.org/wiki/%D0%9F%D1%80%D0%BE%D1%8F%D0%B2%D0%BA%D0%B0
https://ru.wikipedia.org/wiki/%D0%93%D0%B8%D0%B4%D1%80%D0%BE%D1%84%D0%BE%D0%B1%D0%BD%D0%BE%D1%81%D1%82%D1%8C
https://ru.wikipedia.org/wiki/%D0%93%D0%B8%D0%B4%D1%80%D0%BE%D1%84%D0%BE%D0%B1%D0%BD%D0%BE%D1%81%D1%82%D1%8C
https://ru.wikipedia.org/wiki/%D0%93%D0%B8%D0%B4%D1%80%D0%BE%D1%84%D0%BE%D0%B1%D0%BD%D0%BE%D1%81%D1%82%D1%8C
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изображение, из которых следует упомянуть два наиболее распространённых. 

Это печать в несколько прогонов и печать на многокрасочной печатной ма-

шине.  

Наиболее распространённые виды многокрасочных машин имеют соб-

ственные названия: двукрасочные, трёхкрасочные и так далее. Для обеспечения 

точной цветопередачи при печати используются системы контроля, основанные 

на денситометрии, колориметрии, а также цветопроба. 

Плюсы офсетной печати: 

 Наилучшее качество печати 

 Возможность печати на любых видах бумаги и использования лю-

бых видов послепечатной обработки 

 Печать больших тиражей за короткие сроки 

 Значительное удешевление стоимости офсетной печати при боль-

ших тиражах. 

Минусы офсетной печати: 

 При офсетной печати требуется допечатная обработка (цветоделе-

ние, цветопроба, создание форм, печать форм, подготовка пресса, цветобалан-

сировка), что делает невозможным выполнение срочных заказов, например, за 

час 

 Допечатная подготовка и приладка увеличивают стоимость, и пе-

чать малых тиражей может оказаться нерентабельной 

 Персонификация данных при офсетной печати невозможна, правда 

этот минус легко восполняется послепечатной обработкой тиража, например, 

прогоном через цифровую печатную машину. 

Цифровая печать — изготовление тиражной печатной продукции с по-

мощью «цифрового» оборудования. Под цифровым оборудованием понимают 

устройства, печатающие непосредственно из электронных файлов, получаемых 

от рабочих станций, и использующая не офсетную технологию, а технологии 

прямого нанесения красок, так же как в принтерах и ризографах.  

https://ru.wikipedia.org/wiki/%D0%9F%D0%B5%D1%87%D0%B0%D1%82%D0%BD%D0%B0%D1%8F_%D0%BC%D0%B0%D1%88%D0%B8%D0%BD%D0%B0
https://ru.wikipedia.org/wiki/%D0%9F%D0%B5%D1%87%D0%B0%D1%82%D0%BD%D0%B0%D1%8F_%D0%BC%D0%B0%D1%88%D0%B8%D0%BD%D0%B0
https://ru.wikipedia.org/wiki/%D0%94%D0%B5%D0%BD%D1%81%D0%B8%D1%82%D0%BE%D0%BC%D0%B5%D1%82%D1%80
https://ru.wikipedia.org/wiki/%D0%9A%D0%BE%D0%BB%D0%BE%D1%80%D0%B8%D0%BC%D0%B5%D1%82%D1%80
https://ru.wikipedia.org/wiki/%D0%A6%D0%B2%D0%B5%D1%82%D0%BE%D0%BF%D1%80%D0%BE%D0%B1%D0%B0
https://ru.wikipedia.org/wiki/%D0%9E%D1%84%D1%81%D0%B5%D1%82
https://ru.wikipedia.org/wiki/%D0%9F%D1%80%D0%B8%D0%BD%D1%82%D0%B5%D1%80
https://ru.wikipedia.org/wiki/%D0%A0%D0%B8%D0%B7%D0%BE%D0%B3%D1%80%D0%B0%D1%84
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Цифровая офсетная печать — вид печати, совмещающей принцип 

цифровой (в частности, электрофотографической) и офсетной печати.  

Флексографическая печать (флексография, флексопечать) — это спо-

соб печати, который представляет собой прямую высокую ротационную печать 

быстровысыхающими жидкими красками, закрепляющимися на различных 

(чаще — гибких) материалах, с использованием эластичных печатных форм, 

которые могут быть установлены на формных цилиндрах с различной длиной 

окружности. 

Сейчас данный вид печати один из профилирующих видов, с помощью 

которого получают изображение на различных материалах (полиэтилен, поли-

пропилен, целлофан, бумага, гофрокартон, фольга и др). 

Флексографию используют для печати на упаковках, на пластиковых 

пакетах, при производстве этикеток и пр. 

Печатный процесс происходит с помощью специального оборудования: 

печатной формы, печатной машины и тд. Рельефная печатная форма, применя-

емая во флексографии, изготавливается из прессованной резины или из фото-

полимерного материала, её области, печатающее изображение, выступает над 

остальной поверхностью формы. При производстве флексоформ могут быть 

использованы аналоговые и цифровые методы. 

Флексография является методом прямой печати, при котором форма, 

покрытая краской, переносит изображение непосредственно на печатную по-

верхность. Валик красочного аппарата, который называется «анилоксовый ва-

лик», переносит чернила на выпуклые части формы, которые, в свою очередь, 

переносят краску на поверхность. У анилоксового валика есть ячейки, которые 

переносят на форму определенное количество чернил. Количество ячеек, при-

ходящихся на погонный дюйм валика, может варьироваться в зависимости от 

вида печатной продукции и требуемого качества.  

В настоящее время в флексографии используются текучие быстросох-

нущие краски, которые чаще всего разбавляются водой. 

https://ru.wikipedia.org/wiki/%D0%AD%D0%BB%D0%B5%D0%BA%D1%82%D1%80%D0%BE%D1%84%D0%BE%D1%82%D0%BE%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%8F
https://ru.wikipedia.org/wiki/%D0%9E%D1%84%D1%81%D0%B5%D1%82%D0%BD%D0%B0%D1%8F_%D0%BF%D0%B5%D1%87%D0%B0%D1%82%D1%8C
https://ru.wikipedia.org/wiki/%D0%92%D1%8B%D1%81%D0%BE%D0%BA%D0%B0%D1%8F_%D0%BF%D0%B5%D1%87%D0%B0%D1%82%D1%8C
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D1%8D%D1%82%D0%B8%D0%BB%D0%B5%D0%BD
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D0%BF%D1%80%D0%BE%D0%BF%D0%B8%D0%BB%D0%B5%D0%BD
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D0%BF%D1%80%D0%BE%D0%BF%D0%B8%D0%BB%D0%B5%D0%BD
https://ru.wikipedia.org/wiki/%D0%A6%D0%B5%D0%BB%D0%BB%D0%BE%D1%84%D0%B0%D0%BD
https://ru.wikipedia.org/wiki/%D0%91%D1%83%D0%BC%D0%B0%D0%B3%D0%B0
https://ru.wikipedia.org/wiki/%D0%93%D0%BE%D1%84%D1%80%D0%BE%D0%BA%D0%B0%D1%80%D1%82%D0%BE%D0%BD
https://ru.wikipedia.org/wiki/%D0%A4%D0%BE%D0%BB%D1%8C%D0%B3%D0%B0
https://ru.wikipedia.org/wiki/%D0%9F%D0%B5%D1%87%D0%B0%D1%82%D0%BD%D1%8B%D0%B9_%D0%BF%D1%80%D0%BE%D1%86%D0%B5%D1%81%D1%81
https://ru.wikipedia.org/wiki/%D0%9F%D0%B5%D1%87%D0%B0%D1%82%D0%BD%D0%B0%D1%8F_%D1%84%D0%BE%D1%80%D0%BC%D0%B0
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Сублимационная печать — печать, при которой краска при температуре 

180-200 °C и давлении переходит с матовой бумаги на окрашиваемую поверх-

ность.  

Печать наносится на изделия, которые не боятся термообработки, синте-

тические белые ткани (на цветных цвет ткани смешивается с цветом печати), 

сувенирную продукцию, обработанную сублимационным лаком.  

Сублимационная печать может применяться для нанесения изображений 

на ткань. В отличие от других способов печати позволяет наносить на ткань 

фотографические изображения с высоким качеством. Технология позволяет по-

лучить яркие цвета, устойчивые к воздействию окружающей среды. С увеличе-

нием популярности сублимационной печати стали появляться новые материа-

лы, используемые большей частью в рекламной и сувенирной продукции. Осо-

бую популярность приобрели листы крашеного алюминия, керамическая плит-

ка, покрытые слоем особого полимера, в который проникает сублимационная 

краска. Таким образом изготавливаются наградные доски, офисные таблички, 

фотоплитка и многое другое. 

Шелкография. Шелкографией называют разновидность трафаретной пе-

чати, в которой в качестве формного материала используются специальные мо-

новолоконные полиэфирные, полиамидные (нейлоновые) или металлические 

сетки частотой 4-400 нитей/см и толщиной примерно 40-500 мкм. Обычно про-

бельные элементы формируют непосредственно на сетке фотохимическим спо-

собом. Для изготовления печатной формы может быть использован как сухой 

плёночный фотослой (капиллярная плёнка), так и жидкая фотоэмульсия, высу-

шиваемая на сетке после нанесения, а также комбинирование этих двух спосо-

бов. В обычном состоянии фотослой смывается водой. После экспонирования 

УФ-излучением (длина волны 360-420 нм) фотослой полимеризуется и переста-

ёт смываться водой, за исключением участков, не подвергшихся облучению 

(закрытые изображением позитива). Участки со смытым фотослоем становятся 

печатными элементами. В подавляющем большинстве случаев экспонирование 

проводится контактным способом. 

https://ru.wikipedia.org/wiki/%D0%A2%D0%BA%D0%B0%D0%BD%D1%8C
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D0%BC%D0%B5%D1%80
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D1%8D%D1%84%D0%B8%D1%80
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D0%B0%D0%BC%D0%B8%D0%B4
https://ru.wikipedia.org/wiki/%D0%9D%D0%B5%D0%B9%D0%BB%D0%BE%D0%BD
https://ru.wikipedia.org/wiki/%D0%9C%D0%B5%D1%82%D0%B0%D0%BB%D0%BB
https://ru.wikipedia.org/wiki/%D0%9C%D0%BA%D0%BC
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Непосредственно саму печать производят специальными ракелями с по-

лиуретановым полотном, ведя его по верхней (ракельной) стороне сетки (тра-

фарета). Таким образом, краска строго дозировано проходит сквозь сетку в тех 

местах, где нет фотоэмульсии. 

Как правило, печатные формы (сетки) после печати идут на регенерацию 

(смывку фотополимерного слоя) и потом снова применяются в печати. 

Печать соответствующими красками может проводиться практически по 

всем материалам — по бумаге, пластику, ПВХ, стеклу, керамике, металлам, 

тканям, коже, резине и т. д. Краски могут различаться по типу связующе-

го (водные, сольвентные (на основе растворителей), пластизоли, краски для 

стекла и деколей на основе стеклянного наполнителя (фритты), металлического 

пигмента и связующего (медиума)), способу отверждения (ультрафиолетового 

отверждения (водные и традиционные УФ-краски), температурной фиксации 

(пластизоли, водные), воздушной сушки (сольвентные, водные), обжиговые 

краски. 

Своё название «шелкография» этот способ получил из-за патента про-

цесса трафаретной печати, выданного в 1907 году под названием англ. Silk 

screen printing — «печать шелковым ситом».  

Сейчас трафаретная печать применяется не только в полиграфии, но и в 

текстильной, электронной, автомобильной, стекольной, керамической и других 

отраслях промышленности. 

Тиснение — это полиграфический процесс, относящийся к послепечат-

ной отделке продукции, производящийся на ручных, полуавтоматических и ав-

томатических прессах для тиснения, основанный на припрессовке горячим или 

холодным способом металлизированной или пигментной фольги или полимер-

ной пленки с напылением нужного вещества для улучшения привлекательности 

упаковки, этикетки или рекламно-акцидентной продукции. 

3.3. Послепечатная обработка 

Послепечатной обработкой называют все операции с отпечатанной про-

дукцией, которые выполняются после того, как отпечатанный тираж выходит с 

https://ru.wikipedia.org/wiki/%D0%9E%D1%82%D0%B2%D0%B5%D1%80%D0%B6%D0%B4%D0%B5%D0%BD%D0%B8%D0%B5
https://ru.wikipedia.org/wiki/1907_%D0%B3%D0%BE%D0%B4
https://ru.wikipedia.org/wiki/%D0%90%D0%BD%D0%B3%D0%BB%D0%B8%D0%B9%D1%81%D0%BA%D0%B8%D0%B9_%D1%8F%D0%B7%D1%8B%D0%BA
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%8F
https://ru.wikipedia.org/wiki/%D0%9F%D1%80%D0%B5%D1%81%D1%81_%28%D0%BC%D0%B5%D1%85%D0%B0%D0%BD%D0%B8%D0%B7%D0%BC%29
https://ru.wikipedia.org/wiki/%D0%A4%D0%BE%D0%BB%D1%8C%D0%B3%D0%B0
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печатной машины, и до того момента, пака тираж не будет передан заказчику. 

Другими словами, послепечатная обработка – это финальный этап в производ-

стве полиграфической продукции. Некоторые виды послепечатной обработки 

производятся только для отдельных типов печатной продукции, а некоторые – 

для всех сразу.   

 Разрезка листов 

 Биговка 

 Фальцовка 

 Брошюровка 

 Фольгирование 

 Кругление углов 

 Высечка 

 Перфорирование 

 Ламинирование  

Разрезка листов. Конечный размер печатного листа в полиграфии фор-

мируется с помощью листовой резки — этапа послепечатной обработки, кото-

рый не может избежать ни один вид печатной продукции по причине ряда тех-

нологических ограничений, возникающих при печати как офсетом, так и циф-

ровым способом. 

Готовые листы складывают в стопу и обрезают с каждой стороны — так уби-

рают белые поля (так называемая незапечатываемая площадь) и придают ли-

стам точные размеры и нужную форму. Этот этап послепечатной обработки 

называют подрезкой. Часто на одном листе располагается несколько будущих 

экземпляров печатной продукции (например, так печатают визитки), и после 

печати их также разделяют с помощью листовой резки — это будет называться 

разрезкой. Что касается моделей брошюр, каталогов и другой полиграфии, в 

которой не используется пружинный переплет — их обрезают, предварительно 

завершив все технологические операции, в том числе переплетение листов. Это 

вызвано тем, что так получается идеально точный размер листа и аккуратный 

ровный срез готовой печатной продукции.  



17 

 

Биговка. Вид послепечатной обработки полиграфической продукции, 

при котором на бумаге или картоне в местах будущего сгиба обозначается ли-

ния в виде продавленной в бумагу дорожки. С помощью биговки бумажные из-

делия легче обретают требуемую форму, приобретают дополнительную проч-

ность в местах сгиба и избегают растрескивания как бумаги, так и красочного 

слоя.  

Выполняется биговка на специальных биговальных машинах или с по-

мощью тупых ножей. После проведения биговки изделия складывают по этим 

линиям.  

Фальцовка. Фальцовка представляет собой нанесение на бумагу линий 

сгиба без предварительного продавливания тупым ножом и может произво-

диться как вручную, так и на специальном оборудовании. Ручной вариант ис-

пользуется при подготовке небольших тиражей.  

Фальцовка позволяет оформить окончательный вид готовой продукции. 

Это могут быть буклеты, брошюры, каталоги, всевозможная рекламная продук-

ция, чертежи и многое другое. Самый простой пример фальцовки — это ре-

кламная листовка сложенная пополам. 

Брошюровка. Брошюровка — технологический процесс, в результате ко-

торого соединяется некоторое количество листов в тетрадь, так называемую 

брошюру. Брошюрой принято называть издание объемом более 4 страниц блока 

соединенных между собой. Количество листов в изделии ограничивается вы-

бранным способом брошюровки и задачами самой брошюры. Брошюровку ис-

пользуют для такой печатной продукции, как блокноты, брошюры, каталоги, 

тетради и др. Существует три основных вида брошюровки: скрепление скобой 

(скрепкой), клеевое бесшовное скрепление (термоклей) и навивка на пружину. 

Фольгирование. Фольгирование или тиснение фольгой представляет со-

бой операцию нанесения блестящей металлической фольги в виде отдельных 

букв или определенных областей. Это придает эффект серебрения или позоло-

ты, но может быть использована и фольга другого цвета — красного, зеленого, 

синего, желтого и др. Тиснение осуществляется на ручных, полуавтоматиче-
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ских и автоматических прессах для тиснения под воздействием высокой темпе-

ратуры или холодным способом. 

Кругление углов. Кругление углов используется при изготовлении изда-

ний малого формата, чтобы сделать углы более круглыми, которые не загиба-

ются как острые, не ломаются. К тому же после кругления углов изделие при-

обретает более аккуратный внешний вид.  

Кругление углов применяется для календарей, визиток, блокнотов и т.д., 

и может производиться не только на бумажной продукции, но и для изделий из 

пластика (бейджей, бирок), а также на любом другом виде полиграфической 

продукции.  

Высечка. Высечка (вырубка) используется для придания уже готовому 

изображению необходимую форму, отличной от прямоугольной. Высечное 

оборудование позволяет при использовании пресса из цельного листа картона, 

бумаги, пластика или кожи получить форму любой сложности, уже готовую к 

употреблению или же нуждающуюся в последующей сборке. Используется для 

изготовления папок, коробок, воблеров, шелфтокеров, любых полиграфических 

изделий нестандартной формы.  

Перфорирование. Перфорация — это совокупность отверстий, располо-

женных в линию, в листовом или рулонном материале, обеспечивающая легкий 

и точный разрыв материала по этой линии. Создается при помощи специальных 

перфорационных ножей. 

Перфорация используется при изготовлении различной печатной про-

дукции: отрывные календари, блокноты, приглашения, билеты, купоны, почто-

вые марки, наклейки, блокноты на пружине, ежедневники с отрывными угол-

ками.  

Ламинирование. Процесс покрытия изображений специальной прозрач-

ной глянцевой или матовой пленкой толщиной от 80 до 250 мкм с лицевой сто-

роны или с обеих сторон изображения. Данный способ обработки позволяет 

защитить изображение внешних механических, водных, химических, темпера-
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турных воздействий, увеличить плотность изображения и придать привлека-

тельный внешний вид. 

4. ШИРОКОФОРМАТНАЯ ПЕЧАТЬ 

Широкоформатная печать – это цифровая печать на рулонных мате-

риалах (виниловая пленка, бумага, баннерная ткань, сетка).  

Предназначена для изготовления плакатов, растяжек и элементов бо-

лее сложных конструкций наружной рекламы. Печать производится на широ-

коформатных плоттерах различной ширины. 

Готовая продукция, выполненная методом широкоформатной печати, 

представляет собой изображение, нанесенное на рулонный материал. Далее – в 

зависимости от целей рекламной кампании – продукция проходит через произ-

водственный цикл и предстает перед целевой аудиторией в виде рекламных 

щитов, афиш, вывесок, перетяжек, витрин и прочих рекламных носителей. 

Широкоформатную печать можно условно разделить на два направле-

ния: для наружной рекламы и интерьерную.  

Интерьерная печать предполагает, что на изображение смотрят с не-

большого расстояния, следовательно, изображение может быть относительно 

невелико, но должно быть предельно качественно.  

Интерьерная печать идеально подходит для внутреннего оформления 

помещений и изготовления рекламных конструкций, которые планируется ис-

пользовать в закрытом пространстве. 

Интерьерная печать используется для изготовления: 

• элементов оформления выставочных стендов и различных презентаци-

онных конструкций 

• фотографий и репродукций картин для оформления помещений 

• POS-материалов (плакатов, напольной графики, ростовых фигур, 

мобайлов) 

• обоев, натяжных потолков с различными эффектами для эксклюзивно-

го оформления интерьеров 
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Печать для наружной рекламы предназначена для нанесения изображе-

ний, которые должны быть видны издалека, их размеры могут достигать не-

скольких метров и даже десятков метров в ширину.  

Наружная реклама предполагает использование рекламного носителя 

вне помещения, следовательно, он должен быть устойчив к воздействию агрес-

сивной среды. Дождь, снег, перепады температуры, солнечный свет, сильный 

ветер, – все это может повредить носитель, потому технология широкоформат-

ной печати для наружной рекламы предусматривает особую износостойкость 

продукции, что нехарактерно для интерьерной печати. 

Широкоформатная печать, рассчитанная на размещение вне помещения, 

используется для: 

• изготовления перетяжек, баннеров, брандмауэров, табличек, указате-

лей, вывесок и более сложных рекламных конструкций 

• оклейки билбордов и транспортных средств 

• оформления витрин 

5. ПОДГОТОВКА ФАЙЛОВ В ПЕЧАТЬ 

Наиболее распространенные форматы файлов, готовых для печати – 

PDF для полиграфической продукции и TIFF для широкоформатной печати. 

5.1. Формат переносимых документов Adobe PDF  

Формат переносимых документов (PDF) представляет собой универ-

сальный файловый формат, который позволяет сохранить шрифты, изображе-

ния и сам макет исходного документа независимо от того, на какой из множе-

ства платформ и в каком из множества приложений такой документ создавался. 

Формат Adobe PDF считается признанным общемировым стандартом в области 

тиражирования и обмена надежно защищенными электронными документами и 

бланками. Файлы Adobe PDF имеют небольшой размер, и они самодостаточны; 

они допускают совместную работу, просмотр и печать с помощью бесплатной 

программы Adobe Reader®. 

Отлично себя оправдывает использование формата Adobe PDF в изда-

тельском и печатном деле. Благодаря способности Adobe PDF сохранить сов-
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мещенный (композитный) макет, можно создавать компактные и надежные 

файлы, которые сотрудники типографии могут просматривать, редактировать, 

сортировать и получать с них пробные оттиски. Также в предусмотренный тех-

процессом момент в типографии могут как непосредственно отправить файл на 

фотонаборное устройство, так и продолжить его завершающую обработку: 

осуществить предпечатные проверки, провести треппинг, спустить полосы или 

выполнить цветоделение. 

5.2. Подготовка  PDF для печати 

Перед конвертацией в PDF все изображения должны быть переведены в 

CMYK. Если есть элементы, которые печатаются отдельными прогонами (пан-

тоны), им должны быть назначены соответствующие цвета по палитрам Pantone 

Solid Coated/Uncoated. Цветовое пространство CMYK должно быть с указан-

ным в требованиях типографии цветовым профилем. 

5.2.1. Corel Draw (на примере X7, английская версия) 

File >  Publish to PDF>   

 

 

Рис. 2. Конвертация в PDF 
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Указать название файла и указать в настройках для PDF «Prepress» 

 

 

 Рис. 3. Настройки PDF 

 

Settings  >  Compability: Acrobat 4.0 (если по этому пункту нет особых 

требований типографии)  

 

Рис. 4. Версия PDF 

Закладка Color – выбрать вывод цвета CMYK и поставить флажок Em-

bed color profile 
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Рис. 5. Настройкицвета 

Закладка Document – убрать флажок Optimize for fast web view 

 

Рис. 6. Настройки PDF 

 

Закладка Objects – поставить флажок на Export all Text as curves   

 

Рис. 7. Настройки параметров текста 
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Закладка Prepress – поставить флажок на Bleed Limit и указать значение 

5 мм 

 

Рис. 8. Настройки параметров вылетов на обрез 

 

Нажать ОК и сохранить файл. 

 

5.2.2. Adobe Illustator (на примере CC, английская версия) 

File > Save as 

 

Рис. 9. Сохранение в PDF 

 

Выбрать формат файла Adobe PDF 
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Рис. 10. Выбор типа файла 

 

Закладка General: выбрать стандарт, указанный типографией и версию 

файла (Acrobat 4 – если типографией не указано иного), снять флажок с пункта 

Optimize for fast web view 

 

Рис. 11. Настройки PDF 

 

Закладка Compression: указать разрешение не выше 300 ppi для растро-

вых изображений и убрать сжатие (Compression) 
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Рис. 12. Настройки разрешения 

 

Закладка Marks and Bleeds: указать вылеты на обрез по 5 мм, либо по-

ставить флажок Use Document Bleed Settings, если вылеты уже присутствуют в 

макете (были указаны при создании файла) 

 

Рис. 13. Настройки вылетов на обрез 

 

Закладка Output: указать цветовой профиль, в котором должен быть 

сконвектирован документ. Выбрать Include Destination Profiles, если типография 

не требует иного. 
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Рис. 14. Настройки цветового профиля 

 

Нажать Save PDF и сохранить файл. 

 

5.2.3. Adobe InDesign (на примере CC, английская версия) 

File > Export 

 

Рис. 15. Экспорт в PDF 

 

Выбрать формат файла Adobe PDF (Print) 
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Рис. 16. Выбор типа файла 

 

Закладка General: выбрать установку High Quality Print, выбрать стан-

дарт, указанный типографией и версию файла (Acrobat 4 – если типографией не 

указано иного), указать номер страницы документа, снять флажок с пункта Op-

timize for fast web view 

 

Рис. 17. Настройки страницы 

 

Закладка Compression: указать разрешение не выше 300 ppi для растро-

вых изображений и убрать сжатие (Compression) 
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Рис. 18. Настройки разрешения 

 

Закладка Marks and Bleeds: указать вылеты на обрез по 5 мм, либо по-

ставить флажок Use Document Bleed Settings, если вылеты уже присутствуют в 

макете (были указаны при создании файла) 

 

Рис. 19. Настройки вылетов на обрез 

 

Закладка Output: указать цветовой профиль, в котором должен быть 

сконвектирован документ. Выбрать Include Destination Profiles, если типография 

не требует иного. 
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Рис. 20. Настройки цветового профиля 

 

Нажать Save PDF и сохранить файл. 

 

5.2.4. Adobe Photoshop (на примере CC, английская версия) 

File > Save as 

 

Рис. 21. Сохранение в PDF 

 

Выбрать формат файла Adobe PDF 
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Рис. 22. Настройки формата файла 

 

Закладка General: выбрать установку High Quality Print, выбрать стан-

дарт, указанный типографией и версию файла (Acrobat 4 – если типографией не 

указано иного), поставить флажок на Preserve Photoshop Editing Capabilities, 

снять флажок с пункта Optimize for fast web view 

 

Рис. 23. Настройки PDF 

 

Закладка Compression: указать разрешение не выше 300 ppi для растро-

вых изображений и убрать сжатие (Compression) 
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Рис. 24. Настройки разрешения 

 

Закладка Output: указать цветовой профиль, в котором должен быть 

сконвектирован документ. Выбрать Include Destination Profiles, если типография 

не требует иного. 

 

Рис. 25. Настройки цветового профиля 

 

Примечание: в редакторе Adobe Photoshop отсутствует закладка Marks 

and Bleeds, т. к. подразумевается создание файла с заданными вылетами на об-

рез. 

5.3. Формат хранения изображений TIFF   

Расширение TIFF (англ. Tagged Image File Format) – один из наиболее 

популярных форматов хранения растровых графических изображений, исполь-

зующий алгоритм сжатия без потери качества. Изображения TIFF может быть с 



33 

 

любым разрешением и в любом режиме цветов с палитрой: черно-белые, серые 

или цветные. Возможно сохранять изображение в файле формата .TIFF как с 

сжатием LZW, так и без сжатия. 

Данный формат наиболее часто используется для печати широкофор-

матной рекламы. 

5.3.1. Как сделать TIFF для печати? 

Далее будет рассматриваться подготовка в печать макета для планшета 

размером 550х750 мм. 

5.3.2. Corel Draw (на примере X7, английская версия) 

Выделить макет. File >  Export > 

 

Рис. 26. Экспорт в TIFF 

 

Указать название файла и указать формат TIFF, поставить флажок Se-

lected only (Только выбранное) 

 

Рис. 27. Выбор формата файла 
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Проверить размеры (они должны быть в натуральную величину), выста-

вить разрешение 150 dpi (данного разрешения достаточно для такого размера 

планшета), указать цветовой режим CMYK 

 

Рис. 28. Выбор размера и цветового режима 

 

Убрать флажок Transparent background 

 

Рис. 29. Настройки TIFF 

Нажать ОК и сохранить файл. 
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5.3.3. Adobe Illustator (на примере CC, английская версия) 

File >  Export > 

 

Рис. 30. Экспорт в TIFF 

 

Указать название файла и указать формат TIFF 

 

Рис. 31. Выбор формата файла 

 

Указать цветовой режим CMYK, выставить разрешение 150 dpi (данного 

разрешения достаточно для такого размера планшета), снять флажок LZW 

Compression 
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Рис. 32. Выбор размера и цветового режима 

 

Нажать ОК и сохранить файл. 

 

5.3.4. Adobe Photoshop (на примере CC, английская версия) 

Если макет создавался в Adobe Photoshop, сначала необходимо дубли-

ровать изображение, чтобы не потерять послойный исходник. 

Image > Duplicate > 

 

Рис. 33. Создание дубликата файла 

 

В созданном дубликате слить все слои (выполнить сведение) 

Layer > Flatten Image > 
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Рис. 34. Сведение слоев 

File > Save as > 

 

Рис. 35. Сохранение файла 

 

Указать название файла и указать формат TIFF 

 

Рис. 36. Выбор формата файла 
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Поставить флажок Image Compression NONE (Без сжатия), порядок пик-

селей Interleaved, поставить флажок IBM PC (если планируется открывать дан-

ный файл на Intel PC, либо поставить флажок Macintosh, если планируется со-

здать файл для Mac). 

 

Рис. 37. Настройки TIFF 

 

Нажать ОК и сохранить файл. 

6. ОСНОВНЫЕ ПОНЯТИЯ И ТЕРМИНЫ 

6.1. Растровая графика.  

Программы растровой графики работают с точками экрана (пикселями). 

Точки не знают, какие объекты они представляют — окружности, линии, пря-

моугольники. Компьютер запоминает цвет каждой точки, а пользователь из та-

ких точек собирает рисунок, как в детской мозаике.  

Достоинства растровой графики: растровые редакторы являются 

наилучшим средством обработки фотографий и рисунков, т. к. обеспечивают 

высокую точность передачи градаций цветов и полутонов.  

Недостатки растровой графики: изображения, создаваемые в растро-

вых программах, всегда занимают много памяти. По этой причине информация 

в файлах растрового формата хранится, как правило, в сжатом виде. Растровые 

изображения невозможно увеличивать для уточнения деталей. Так как изобра-

жение состоит из точек, то увеличение приводит к тому, что точки становятся 
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крупнее, что визуально искажает иллюстрацию. Этот эффект называется пиксе-

лизацией.  

Графические редакторы, в которых используется растровая графика: 

Adobe Photoshop.  

6.2. Векторная графика.  

Программы векторной графики хранят информацию об объектах, со-

ставляющих изображение в виде графических примитивов: прямых линий, дуг 

окружностей, прямоугольников  и т. д.  

Достоинства векторной графики: преобразования без искажений, вы-

сокая точность прорисовки (до 1 000 000 точек на дюйм).  

Недостатки векторной графики: векторные изображения выглядят ис-

кусственно. Ограниченность в живописных средствах.  

Графические редакторы, в которых используется векторная графика: 

Corel Draw , Adobe Illustrator.  

6.3. Термины предпечатной подготовки. 

Растровое изображение. Растровым называется изображение, состоя-

щее из массива точек – пикселей.  

Пиксел – это элементарный, то есть наименьший и уже неделимый эле-

мент двухмерного цифрового изображения прямоугольной или круглой формы 

определенного цвета. В то же время, пиксел – это и физический элемент матри-

цы устройств вывода - дисплеев.  

Размер растрового изображения – это ширина и высота рисунка в пик-

селах. 

Разрешение растрового изображения – это количество пикселей на 

единицу. Чем выше разрешение, тем больше пикселей расположено в дюйме. 

Тем более мелкими они будут. И тем более четкими будут детали изображения, 

более точным будет отображение оригинала. Разрешение измеряется в dpi (dots 

per inch) – количестве точек на дюйм. Для полиграфической печати разрешение 

изображения должно быть 300 dpi.  
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Вылеты на обрез — припуски к обрезному формату, которые необходи-

мо создавать, когда часть изображения уходит «под обрез», то есть линия реза 

проходит не по пустому полю незапечатанной бумаги, а по картинке. 

В случае, если вылеты не оставлены, по границе листа после подрезки 

могут образовываться полоски незапечатанной бумаги, причём, при неаккурат-

ной резке они будут иметь разную ширину в разных частях изображения, то 

есть будут оставлять впечатление косого реза. Кроме того, велика вероятность 

того, что с разных сторон листа белые области будут разного размера, что уси-

лит ощущение неаккуратности работы. 

Типографии предъявляют различные требования к вылетам, от 1 мм до 5 

мм с каждой стороны. Эта информация обычно содержится в технических тре-

бованиях типографии. 

Зона вылетов зависит от вида продукции, в которых разная точность 

резки частей или всего изделия диктует необходимый размер. В требованиях 

типографии оговаривается минимальная зона вылетов. Для большинства изде-

лий достаточной зоной является 3 мм. 

6.4. Цветовой режим 

Цветовой режим, или режим изображения, определяет, как объединяют-

ся цвета на основе количества каналов в цветовой модели. Разные цветовые ре-

жимы дают различные уровни детализации цвета и размер файла. Например, 

цветовой режим CMYK используется для изображений в полноцветной печат-

ной брошюре, а цветовой режим RGB для изображений, предназначенных для 

интернета или электронной почты, чтобы уменьшить размер файла, сохраняя 

достоверность цветов. 
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Режим CMYK. В режиме CMYK пикселу для каждой из триадных кра-

сок присваивается значение в процентах. Самым светлым цветам (цветам под-

светки) назначается меньшее значение, а более темным (цветам тени) — боль-

шее. Например, ярко-красный цвет может состоять из 2 % голубого, 93 % пур-

пурного, 90 % желтого и 0 % черного. Если в изображениях CMYK все четыре 

компонента равны 0 %, то получается чистый белый цвет. 

Режим CMYK предназначен для подготовки изображения к печати с ис-

пользованием триадных цветов. В режиме CMYK можно также работать непо-

средственно с изображениями CMYK, полученными со сканера или импорти-

рованными из профессиональных систем. 

Несмотря на то что CMYK — это стандартная цветовая модель, точный 

диапазон воспроизводимых цветов может различаться в зависимости от печат-

ной машины и условий печати.  

Что такое цветовой профиль? 

Цветовой профиль — это подробное описание свойств воспроизведения 

цвета конкретным устройством. Он представляет собой файл с расширением 

*.icc или *.icm, в котором содержится информация о том, какие конкретно цве-

товые ощущения возникают при том или ином сочетании красок, если речь 

идет о печатном устройстве, или яркостях светящихся элементов, если речь 

идет о мониторе. 

Каждое устройство, получающее или показывающее цвета, может иметь 

свой профиль. Некоторые производители снабжают свои продукты профилями. 

При подготовке в печать этот параметр обычно указывается типографи-

ей в требованиях к печати. 
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ЗАКЛЮЧЕНИЕ 

Освоение теоретического материала данного пособия способствует 

успешному выполнению студентами графического раздела курсовой работы, 

т. к. здесь изложены основы процесса подготовки графического материала к 

печати в типографии, приведены основные требования типографии к макету.  

Также предлагаемый в пособии алгоритм подготовки макета в печать 

может служить основой для дальнейшего совершенствования и углубления 

знаний в процессе работы с графическими материалами.  

Таким образом, создается возможность использовать изложенный мате-

риал при выполнении графической части студенческих работ направления 

подготовки 54.03.01 «Дизайн», профиль «Графический дизайн» в освоении 

дисциплины «Технологии полиграфии»», а также в практической дизайнер-

ской деятельности. 
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